Bonus Chapter 2
Managing Your Content

In This Chapter

Minimizing audio quality trade-offs when using import encoders

Understanding how MP3, AAC, and Lossless encoders use compression
Choosing the appropriate encoder and changing import settings

Converting songs to a different encoding format in iTunes

Using your iPod for backing up full-resolution images and files

Organizing photos on your computer into photo albums

Renting movies from the iTunes Store and managing your iTunes Store account
Exporting and converting video files for iPods, iPhone, and Apple TV

Tlis chapter is about managing your iTunes library content — everything
from choosing the appropriate audio encoding format for your songs,

to organizing your photos into libraries for easier synchronization with your
iPod or iPhone, to preparing videos for use on your iPod, iPhone, or Apple
TV.Ialso describe how to use your iPod classic to transfer high-resolution
photos to another computer or to make a backup of your photos in their
original resolutions.

As you discover more about digital audio technology, you find that you have
more decisions to make about your music than you previously thought. This
chapter is here to help you make those decisions. The encoding format and
settings that you choose for importing music when ripping a CD affect sound
quality, iPod or iPhone space, and computer hard drive space. The format
and settings you choose might also affect whether the music files can play on
other types of players and computers. In this bonus chapter, I explain which
music encoding and compression formats to use for higher quality as well as
which ones to use for cramming more songs on your hard drive.
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When importing music, you might be tempted to trade quality for space,
importing at average-quality settings that allow you to put more songs on
your hard drive and iPod than if you chose higher-quality settings. This
choice might make you happy today, but what about tomorrow, when iPods
and iPhones — and computer hard drives — double or triple in capacity?

On the other hand, you might be very picky about the sound quality. With an
eye toward future generations of iPods and inexpensive hard drives, maybe
you decide to trade space for quality, importing music at the highest-possible
quality settings and then converting copies to lower-quality, space-saving
versions for iPods and other uses. Of course, you’d need more hard drive
space to accommodate the higher-quality versions.

If you want your audio files to take up less space, you have to compress the
audio. (For “compress” here, think “throw away information.”) In technospeak,
such compression methods are lossy (the opposite of lossless) compression
algorithms. For example, AAC and MP3 encoding formats compress the
sound via lossy methods. Lossy compression algorithms reduce the sound
quality by throwing away information to make the file smaller, so you lose
information and some quality in the process. Comparatively, the Apple
Lossless encoder compresses sound files without any loss in quality or
information, but the resulting file is only a bit smaller than the uncompressed
version. The main reason to use Apple Lossless is to maintain quality for
burning CDs while also playing the songs on iPods. Apple Lossless, and the
AIFF and WAV encoders that don’t compress the sound at all, are the best
choices when burning CDs.

With lossy compression formats, such as MP3 or AAC, the amount of
compression depends on the bit rate that you choose as well as the encoding
format and other options. Bit rate determines how many bits (of digital music
information) can travel during playback in a given second. Measured in
kilobits per second (Kbps), a higher bit rate such as 320 Kbps offers higher
quality than a bit rate of 192 Kbps because the sound isn’t compressed as
much. Thus, the resulting sound file is larger, taking up more iPod and hard
drive space.

Using more compression (a lower bit rate) means that the files are smaller, but
the sound quality is poorer. Using less compression (a higher bit rate) means
that the sound is higher in quality, but the files are larger. Here’s the deal: You
can trade quality for space and have more music of lower quality, or you can
trade space for quality and have less music of higher quality.
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iPod power consumption is also an issue to keep in mind when making
compression choices. Playing larger files takes more power because the hard
drive inside the iPod has to refresh its memory buffers frequently to process
information as the song plays. You might even hear hiccups in the sound.

[ prefer a higher-quality sound, and I typically don’t use the lower-quality
settings for encoders except for voice recordings and music recorded in
ancient times (cough: before 1960). (Older recordings are already low in
quality, so you don’t hear that much of a difference when they’re compressed.)
And because I can hear differences in music quality at the higher compression
levels, I just buy another hard drive for storage to accommodate larger

files. To discover how to manage multiple iTunes libraries over several hard
drives, see Bonus Chapter 3. Only you can know what works best for you, so
try encoding at different settings and listen to the results before deciding.

Choosing an iTunes encoder

iTunes gives you a choice of encoders. This choice is perhaps the most
important one to make before starting to rip music CDs and building your
library. Here, I leapfrog years of technospeak about digital music file formats
and get right to the ones that you need to know.
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If you are using MusicMatch Jukebox, see the free tips section of the author’s
Web site (www . tonybove. com).

Choose iTunes=Preferences (Mac) or Edit=>Preferences (Windows), click the
General tab (if it is not already selected), and then click the Import Settings
button to see the import settings. You can choose one of five encoders from
the Import Using pop-up menu:

v AAC: All music purchased from the iTunes Store comes in MPEG-4
Advanced Audio Coding (AAC) format. (MPEG — the Moving Picture
Experts Group — is a committee that establishes compression standards
for video and audio.) AAC is a higher-quality format than MP3 at the
same bit rate, meaning that AAC at 128 Kbps is higher quality than MP3
at 128 Kbps. I recommend using AAC for most import operations —
except when ripping your CDs to burn new audio CDs (see AIFF, WAV, or
Apple Lossless) or to burn a new MP3 CD (see MP3).

I think the AAC encoder offers the best trade-off of space and quality
for iPod users. It’s suitable for burning to an audio CD (although not as
good as AIFF or Apple Lossless), and it’s excellent for playing songs on
an iPod or from a hard drive. However, it is not suitable for burning MP3
CDs or for playing songs on players other than iPods.
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v AIFF: Audio Interchange File Format is the standard digital format for

uncompressed sound on a Mac, and it provides the highest-quality
digital representation of sound. Similar to a WAV encoder for Windows,
an AIFF encoder uses a platform-specific version of the original Pulse
Code Modulation (PCM) algorithm required for compliance with audio CDs.

Use AIFF if you plan to burn songs onto an audio CD or to edit the songs
with a digital sound-editing program. Mac-based sound-editing programs
import and export AIFF files, and you can edit and save in AIFF format
repeatedly with absolutely no loss in quality. The downside is that AIFF
files take up enormous amounts of hard drive and iPod space — 10MB
per minute — because they’re uncompressed. Don’t use AIFF for songs
that you want to play on an iPod. Use the Apple Lossless encoder, AAC,
or MP3 instead.

v Apple Lossless: The Apple Lossless encoder is a compromise between

the lower-quality encoding of AAC or MP3 (which results in smaller file
sizes) and the large file sizes of uncompressed, high-quality AIFF or WAV
audio. The Apple Lossless encoder provides CD-quality sound in a file
size that’s about 60 to 70 percent of the size of an AIFF- or WAV-encoded
file. The virtue of this encoder is that you can use it for songs that you
intend to burn onto audio CDs and for playing on iPods. The files are just
small enough that they don’t hiccup on playback, but they’re still much
larger than their MP3 or AAC counterparts.

Using the Apple Lossless encoder is the most efficient method of storing
the highest-quality versions of your songs. You can burn the songs to CD
without any quality loss and still play them on your iPod. You can’t store
as many songs on your iPod as with AAC or MP3, but the songs that you
do store have the highest-possible quality.

v MP3: The MPEG-1, Audio Layer 3 format (also known as MP3) is supported

by most computers, many DVD players, and some CD players. Use the
MP3 format for songs that you intend to use with MP3 players other
than your iPod (which also plays MP3 songs, obviously). Or, use MP3
with applications that support MP3 or when burning to an MP3 CD.
(AIFF, WAV, or Apple Lossless formats are better for regular audio CDs

in my opinion, but you can burn audio CDs with MP3-formatted songs as
well.) The MP3 format offers quite a few compression and quality
settings, so you can fine-tune the format, sacrificing hard drive (and
iPod) space while improving the quality.

v WAV: Waveform Audio File Format is a digital audio standard that

Windows PCs can understand and manipulate. Like AIFF, WAV is
uncompressed and provides the highest-quality digital representation
of the sound. Similar to what the AIFF encoder does for a Mac, a WAV
encoder uses a Windows-specific version of the original PCM algorithm
required for compliance with audio CDs.
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Use WAV if you plan to burn a song to an audio CD or use the song

with Windows-based digital sound-editing programs, which import and
export WAV files. (AIFF and WAV files are the same, except that AIFF
works with Mac applications and WAV works with Windows applications.)
WAV files take up enormous amounts of hard drive and iPod space —
10MB per minute — because they’re uncompressed. Don’t use WAV for
songs that you want to play on an iPod. Use the Apple Lossless encoder,
AAC, or MP3 instead.

If you want to share your music with someone who uses an MP3 player other
than an iPod, you can import or convert songs with the MP3 encoder. You
can also use the higher-quality AAC encoder to produce files for iPod, iPhone,
and other MP3 players that support AAC — and these files are either the
same size as their MP3 counterparts but higher in quality, or the same quality
but smaller in size.

For the best possible quality, consider not using compression at all (like with
AIFF or WAV) or using Apple Lossless. You can import music at the highest
quality, burn it to audio CDs, and then convert it to a lesser-quality format for
use on an iPod, iPhone, Apple TV, or other device. If you use Apple Lossless
for songs, you can use those songs on an iPod, iPhone, or Apple TV, but they
take up much more space than AAC- or MP3-encoded songs. | describe how
to convert music in the section “Converting Songs to a Different Encoder
Format in iTunes,” later in this chapter.

Manic compression has
captured your song

Every person hears the effects of compression differently. You might not
hear any problem with a compressed song that someone else says is tinny or
lacking in depth.

x‘&N\BEB Too much compression can be a bad thing. Further compressing an already-
& compressed music file — say, by converting a song — reduces the quality
significantly. Not only that, but after your song is compressed, you can’t
uncompress the song to its original quality. Your song is essentially locked
into that quality, at best.

The lossy-style compression of the MP3 and AAC formats loses information each
time you compress, which means that if you compress something already
compressed, you lose even more information. This is bad. Don’t compress
something that’s already compressed from a lossy method, unless you have to.
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The past, present, and future of music

My suggestions for encoder choice and import-
ing preferences for ripping CDs are mostly sub-
jective. Your listening pleasure depends entirely
on your taste and how the song was recorded.
Some people can hear qualitative differences
that others don't hear or don't care about. Some
people can also tolerate a lower-quality sound
in exchange for the convenience of carrying
more music on their iPods. And sometimes the
recording is so primitive-sounding that you can
get away with using lower-quality settings to
save more hard drive space.

Formats for recording sound have changed
considerably from brittle 78-rpm records of
the early 1900s and the scratchy 45-rpm and
33-rpm records of the mid-1900s to today's CDs.
Consumers had to be on the alert then, as you
do now, for formats that die off as better ones
come along. Think of the ill-fated 8-track car-
tridge or the legendary quadraphonic LP. You
want your digital music to last forever yet still
play at high quality — and not get stuck with
technology that doesn't evolve with the times.

Digital music has evolved beyond the com-
mercial audio CD, and computers haven't yet
caught up to some of the latest audio formats.
For example, iTunes can't yetimport sound from
these formats:

v DVD-audio: DVD-audio is a digital audio
format developed from the DVD video
format. DVD-audio doesn’t include video
and shouldnt be confused with video DVDs
that contain concerts and music videos.
DVD-audio is based on PCM recording
technology but offers improved sound qual-
ity. Neither iTunes nor MusicMatch Jukebox
support the DVD-audio format, but you can
import a digital video file containing DVD-
audio sound into iMovie, extract the sound,
and export the sound in AIFF or WAV format,
which you can use with iTunes. You can also

use Toast 10 from Roxio (www.roxio.
com) to import and burn DVD-audio. You
can maintain its sampling frequency of
48 kHz (which is higher than the 44.1-kHz
sampling rate of audio CDs) by setting the
Sample Rate pop-up menu in the custom
settings for AIFF or WAV to 48.0 kHz.

v~ Super Audio CD (SACD): Super Audio CD
is a format developed from the past audio
format for CDs. The SACD format is based on
Direct Stream Digital (DSD) recording tech-
nology that closely reproduces the shape of
the original analog waveforms to produce a
more natural, higher-quality sound. Originally
developed for the digital archiving of price-
less analog master tapes, DSD is based on
1-bit, sigma-delta modulation and operates
with a sampling frequency of 2.8224 MHz (64
times the 44.1 kHz used in audio CDs). Philips
and Sony adopted DSD as the basis for
SACD, and the formatis growing in popularity
among audiophiles. However, neither iTunes
nor MusicMatch Jukebox supports SACD. If
you buy music in the SACD format, choose
the hybrid format that offers a conventional
CD layer and a high-density SACD layer. You
can then import the music from the conven-
tional CD layer.

You might also want to take advantage of the
compression technology that squeezes more
music onto your iPod, iPhone, or Apple TV.
Although the Apple-supported AAC format
offers far better compression and quality than
MP3 format (at the same bit rates), the MP3
format is used more because it's supported by
other players and software programs as well as
iPods and iTunes. Sticking with AAC or Apple
Lossless as your encoder might make you feel
like your songs are stuck inside iTunes with the
MP3 blues again. However, with iTunes and
your iPod, iPhone, or Apple TV, you can mix and
match these formats as you please.
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For example, iTunes in Windows can convert unprotected Windows Media
Audio (WMA) files to the AAC format, but the conversion includes another
lossy compression step to AAC, lessening the quality because most WMA
files were already compressed with a lossy method. If you have the CD of the
music, you're better off ripping the music again from the CD directly into the
AAC format. An alternative is to use the WMA Lossless format in Windows.
The Windows version of iTunes correctly converts WMA Lossless files into
Apple Lossless with no loss of information or quality.

The Apple Lossless encoder doesn’t use a lossy method, which is why it’s
called lossless — information isn’t thrown away. Even though Lossless
compresses to about 60-70 percent of the original sound file, that’s not enough
of a reduction in space for most people; MP3 and AAC compress sound files to
about 10 percent of the original size.

MP3 and AAC use two basic lossy methods to compress audio:

+* Removing nonaudible frequencies: The compression removes what
you supposedly can’t hear (although this subject is up for debate). For
example, if a background singer’s warble is totally drowned out by the
intensity of a rhythm guitar chord, the compression algorithm loses the
singer’s sound while maintaining the guitar’s sound.

+* Removing less important signals: Within the spectrum of sound
frequencies, some frequencies are considered to be less important in
terms of rendering fidelity, and most people can’t hear some frequencies.
Removing specific frequencies is likely to be less damaging to your
music than other types of compression, depending on how you hear
things. In fact, your dog might stop getting agitated at songs that contain
ultra-high frequencies that only dogs can hear (such as the ending of
“Day in the Life” by The Beatles).

Selecting import settings

AAC and MP3 formats compress sound at different quality settings. iTunes
lets you set the bit rate for importing, which determines the audio quality.
You need to use a higher bit rate (such as 192 Kbps or 320 Kbps) for higher
quality, which — all together now! — increases the file size.

Variable Bit Rate (VBR) encoding is a technique that varies the number of bits
used to store the music, depending on the complexity of the sound. Although
the quality of VBR is endlessly debated, it’s useful when set to the highest
setting because VBR can encode at up to the maximum bit rate of 320 Kbps in
those rare cases where the sound requires it, but it keeps the majority of the
sound at a lower bit rate.

Bonus Chapter 2: Managing Your Content BCZ ’
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iTunes also lets you control the sample rate during importing, which is

the number of times per second the sound waveform is captured digitally
(sampled). Higher sample rates yield higher-quality sound and large file sizes.
However, never use a higher sample rate than the rate used for the source.
CDs use a 44.100-kHz rate, so choosing a higher rate is unnecessary unless
you convert a song that was recorded from Digital Audio Tape (DAT), DVD, or
directly onto the computer at a high sample rate, and you want to keep that
sample rate.

Another setting to consider during importing is the Channel choice. Stereo,
which offers two channels of music for left and right speakers, is the norm
for music. However, mono — monaural or single-channel — was the norm
for pop records before the mid-1960s. (Phil Spector was known for his high-
quality monaural recordings. And early Rolling Stones records are also
recorded in mono.) Monaural recordings take up half the space of stereo
recordings when digitized. Most likely, you want to keep stereo recordings in
stereo and mono recordings in mono.

Changing Encoders and Encoder Settings

QEWER

WBER
‘x&
&

525678-bc02.indd BC22

You might want to change your import settings before ripping CDs, depending
on the type of music, the source of the recording, or other factors, such as
whether you plan to copy the songs to your iPod, iPhone, or Apple TV, or
to burn an audio or MP3 CD. Encoders offer general quality settings, but
you can also customize encoders and change those settings to your liking.
Whether you use iTunes or MusicMatch Jukebox, the software remembers
your custom settings until you change them again.

For information about MusicMatch Jukebox, see the free tips section of the
author’s Web site (www . tonybove . com).

You can also convert songs to another format, as [ describe in the later
section “Converting Songs to a Different Encoder Format in iTunes.” However,
you can’t convert copy-protected songs that you bought from the iTunes Store
last year because they're encoded as protected AAC files. (If you could, they
wouldn’t be protected, would they?) You can convert protected songs (for a
fee) to the newer unprotected “iTunes Plus” format now used throughout the
iTunes Store, but if you convert a compressed song into another compression
format, you lose audio quality. You also can’t convert Audible audio books and
spoken-word content to another format; you can burn them to an audio CD
and reimport them, but that might cause a noticeable drop in quality.
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Customizing the encoder settings in iTunes

To change your encoder settings, quality settings, and other importing
preferences before ripping an audio CD or converting a file in iTunes, follow
these steps:

1. Choose iTunes=>Preferences (Mac) or Edit=>Preferences (Windows),
click the General tab and then click the Import Settings button.

The import settings appear, allowing you to make changes to the
encoding format and its settings.

2. From the Import Using pop-up menu, choose the encoding format that
you want to convert the song into and then select the settings for that
format.

The Setting pop-up menu differs depending on your choice of encoder
from the Import Using pop-up menu. See the sections on each encoding
format later in this chapter for details on settings.

3. Click the OK button to accept your changes.

After changing your importing preferences — and until you change them
again — iTunes uses these preferences whenever it imports or converts
songs.

AAC, MP3, AIFF, and WAV encoders let you customize the settings. The Apple
Lossless encoder is automatic and offers no custom settings.

Changing AAC encoder settings

[ recommend using the AAC encoder for most types of music — except songs
that you intend to burn to an audio CD or an MP3 CD — because AAC offers
the best trade-off of space for hard drives and iPods as well as quality.

The Setting pop-up menu for the AAC encoder offers four choices: High
Quality (128-Kbps stereo), iTunes Plus (256-Kbps stereo), Spoken Podcast
(64-Kbps stereo), and Custom. The Spoken Podcast setting is useful for
converting podcasts exported from GarageBand (or a similar audio-editing
application) into iTunes. | recommend using the iTunes Plus setting for most
music you rip from CDs, or the Custom option to set a higher bit rate. To set
a higher bit rate or other options, choose Custom from the Setting pop-up
menu to see the AAC Encoder dialog, as shown in Figure BC2-1.

Bonus Chapter 2: Managing Your Content BC23
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Figure BC2-1:
Setthe AAC
encoder to
import with
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AAC Encoder

(_ Default Settings )

Stereo Bit Rate: | 320 kbps [ s
Sample Rate: [ Auto &
Channels: | Auto o

] Use Variable Bit Rate Encoding (VBR)
"1 Use High Efficiency Encoding (HE)

1 Optimize for voice

(_ Cancel ) w0k

The Custom settings for AAC give you the following options:

v Stereo Bit Rate: This pop-up menu allows you to select the bit rate,

which is measured in kilobits per second (Kbps). Using a higher bit rate
gives you higher quality but also increases file size. The highest-quality
setting for this format is 320 Kbps; 256 Kbps, considered higher quality,
is the bit rate for the unprotected “iTunes Plus” songs that Apple provides
in the iTunes store.

+~ Sample Rate: This pop-up menu enables you to select the sample rate,

which is the number of times per second that the sound waveform is
captured digitally (sampled). Higher sample rates yield higher-quality
sound and larger file sizes. However, never use a higher sample rate than
the rate used for the source. CDs use a 44.1-kilohertz (kHz) rate.

v Use Variable Bit Rate Encoding (VBR): This option helps keep down

file size, but quality might be affected. VBR varies the number of bits
used to store the music depending on the complexity of the sound.
iTunes encodes up to the maximum bit rate of 320 Kbps in sections of
songs where the sound is complex enough to require a high bit rate.
Meanwhile, iTunes keeps the rest of the song at a lower bit rate to save
file space. The lower limit is set by the rate that you choose from the
Stereo Bit Rate pop-up menu. If you chose the VBR option, the highest
rate you can set (which is the lower limit of VBR) is 256 Kbps, and other
rates that don’t work with VBR are grayed out.

v Use High Efficiency Encoding (HE): High-Efficiency Advanced Audio

Coding (HE-AAC) is a lossy data compression method for AAC that is
optimized for low bit-rate audio, such as streaming audio.

v Channels: From this pop-up menu, you can choose how you want music

to play through the speakers: in stereo or in mono. Stereo, which offers
two channels of music for left and right speakers, is the standard for
music. Monaural (mono) offers only one channel but takes up half the
space of stereo recordings when digitized. If the recording is in stereo,
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don’t choose mono because you lose part of the sound. (You might lose
vocals or guitar riffs, depending on the recording.) Select Auto to have
iTunes use the appropriate setting for the music.

v+ Optimize for Voice: This option filters the sound to favor the human
voice. Podcasters can use this option to convert audio recordings into a
podcast format that’s optimal for iTunes.

[ recommend choosing the highest bit rate (320 Kbps) from the Stereo Bit Rate
pop-up menu, leaving VBR, HE, and voice optimization off, and leaving the
other two pop-up menus set to Auto.

Changing MP3 encoder settings

I prefer using AAC encoding for music that [ play on my iPods and my
iPhone, as well as my Apple TV, but as of this writing, many MP3 players
don’t support AAC. The iPod, iPhone, and Apple TV support both AAC and
MP3 formats. You might want to use MP3 encoding for other reasons, such
as acquiring more control over the compression parameters and gaining
compatibility with other applications and players that support MP3.

The MP3 encoder offers four choices for the Setting pop-up menu on the
Importing preferences tab:

v Good Quality (128 Kbps): This bit rate is certainly fine for audio books,
comedy records, and scratchy records. You might even want to use a
lower bit rate for voice recordings.

v High Quality (160 Kbps): Most people consider this bit rate high enough
for most popular music, but I go higher for my music.

v Higher Quality (192 Kbps): This bit rate is high enough for just about all
types of music.

v Custom: To fine-tune MP3 encoder settings, select the Custom setting.
Customizing your MP3 settings increases the sound quality and keeps
the file size small.

The MP3 encoder offers many choices in its custom settings dialog (see
Figure BC2-2):

1 Stereo Bit Rate: This pop-up’s menu choices are measured in Kbps.
Choosing a higher bit rate gives you higher quality but also increases file
size. The most common bit rate for MP3 files that you find on the Web is
128 Kbps. Lower bit rates are more appropriate for voice recordings or
sound effects.

I recommend at least 192 Kbps for most music. [ use 320 Kbps, the maximum
setting, for songs that I play on my iPods, iPhone, and Apple TV.

Bonus Chapter 2: Managing Your Content BC25
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Figure BC2-2:
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MP3 Encoder

( : Yy
_Use Default Settings

Stereo Bit Rate: | 192 kbps 4
# Use Variable Bit Rate Encoding (VBR)

Quality: '_ Highest %

(With VER enabled, bit rate settings are used for a guaranteed minimum bit rate.)

Sample Rate: | Auto ==
Channels: | Auto
Stereo Mode: | Normal 'y

# Smart Encoding Adjustments

SRECRE

@ Filter Frequencies Below 10 Hz

Cancel 0K R‘"\

v Use Variable Bit Rate Encoding (VBR): This option helps keep down
file size, but quality might be affected. VBR varies the number of bits
used to store the music depending on the complexity of the sound. For
MP3, the VBR option includes a Quality pop-up menu right below the
option. If you choose Highest from the Quality pop-up menu for VBR,
iTunes encodes up to the maximum bit rate of 320 Kbps in sections of
songs where the sound is complex enough to require a high bit rate.
Meanwhile, iTunes keeps the rest of the song at a lower bit rate to save
file space. The lower limit is set by the rate that you choose from the
Stereo Bit Rate pop-up menu.

Some audiophiles swear by VBR, but others don’t ever use it. I use it only
when importing at low bit rates, and I set VBR to its highest-quality setting.

Your iPod, iPhone, or Apple TV can play VBR-encoded MP3 music, but
other MP3 players might not support VBR.

v~ Sample Rate: From this pop-up menu, you can choose the sample rate
(how many times per second the sound waveform is captured digitally).
Higher sample rates yield higher-quality sound and larger file sizes.
However, never use a higher sample rate than the rate used for the

source: For example, CDs use a 44.1-kHz rate, while DVDs use the higher

48kHz rate. Use the higher rate for audio that you intend to use with
iDVD on a Mac (or similar DVD-burning application in Windows) to
create a DVD.

v Use High Efficiency Encoding (HE): High-Efficiency Advanced Audio
Coding (HE-AAC) is a lossy data compression method for AAC that is
optimized for low bit-rate audio, such as streaming audio.

v+ Channels: From this pop-up menu, choose how you want music to play

through the speakers: in stereo or in mono. Stereo, which offers two chan-

nels of music for left and right speakers, is the standard for music. Mono
recordings take up half the space of stereo recordings when digitized.
Choose Auto to have iTunes use the appropriate setting for the music.
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v Stereo Mode: From this pop-up menu, choose Normal or Joint Stereo.
Normal mode is just what you think it is — normal stereo. Choose the
Joint Stereo setting to make the file smaller by removing information
that’s identical in both channels of a stereo recording, using only one
channel for that information while the other channel carries unique
information. At bit rates of 128 Kbps and lower, this mode can actually
improve the sound quality. However, I typically don’t use Joint Stereo
mode when using a high-quality bit rate.

+* Smart Encoding Adjustments: Selecting this option tells iTunes to
analyze your MP3 encoding settings and music source, changing your
settings as needed to maximize the quality of the encoded files.

v~ Filter Frequencies below 10 Hz: Selecting this option filters low
frequencies. Frequencies lower than 10 hertz (Hz) are difficult to hear,
and most people don’t notice that they’re missing. Filtering inaudible
frequencies helps reduce the file size with little or no perceived loss in
quality. However, I think that selecting this option and removing the low
frequencies detract from the overall feeling of the music; thus, I prefer
not to filter frequencies.

Changing AIFF, WAU, and Apple Lossless encoder settings

[ recommend using AIFF, WAV, or Apple Lossless encoders for songs from
audio CDs that you intend to burn. You get the best possible quality with
these encoders because the music isn’t compressed with a lossy algorithm.
The Apple Lossless encoder (which is automatic and offers no settings to
change) reduces the file size to about 60 to 70 percent of the AIFF or WAV
versions. However, AIFF or WAV files are preferable for use with digital sound-
editing programs, and they offer settings that you can change, such as the
number of channels (stereo or mono) and the sampling rate.

Although AIFF and WAV formats have technical differences, here’s the only
major difference in storing and playing music: AIFF is the standard for Macs
and their applications, and WAV is the standard for PCs and their applications.

You can import music with an AIFF or a WAV encoder at the highest-possible
quality and then convert the music files to a lesser-quality format for use on
your iPod, iPhone, or Apple TV.

AIFF- and WAV-encoded files take up huge amounts of hard drive space (about
10MB per minute). Although you can play these file types on an iPod, iPhone,
or Apple TV, they take up way too much space and battery power to be
convenient for anyone but the most discerning audiophile who can afford
multiple devices. You can handle these large files by adding another hard
drive or by backing up portions of your music library onto other media,

such as DVD-R (which can hold 4.38GB). The high quality of AIFF- and
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WAV-encoded files ensures an excellent listening experience through a home
stereo. However, if multiple hard drives and backup scenarios sound like
unwanted hassles, use AAC or MP3 encoding to compress files so that they
take up less space on your hard drive.

The AIFF and WAV encoder dialogs offer similar pop-up menus for Sample Rate
(the number of times per second the sound waveform is captured digitally, or
sampled), Sample Size (the size of the captured sample, which can be 8 bits for
lower quality or 16 bits for higher quality), and Channels (Mono or Stereo). If
you choose Auto for all three, iTunes automatically detects the proper sample
rate, size, and channels from the source. If you choose a specific setting —
such as Stereo, from the Channels pop-up menu — iTunes imports the music
in stereo, regardless of the source. Audio CDs typically sample at a rate of 44.1
kHz, with a sample size of 16 bits, and with stereo channels.

The Sample Rate pop-up menu for AIFF and WAV encoders offers more
choices than AAC, down to a very low sample rate of 8 kHz, which is suitable
only for voice recordings.

Importing Voice and Sound
Effects in iTunes

A\\S
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Audio books from Audible (www.audible.com) and from the iTunes Store
are available in a special format that doesn’t require any further compression.
However, you can also import audio books, spoken-word titles, comedy CDs,
and other voice recordings in MP3 format (and also in the unprotected WMA
format using the Windows version of iTunes).

If the recording has any music or requires close listening to stereo channels
(such as a Firesign Theatre or Monty Python CD), treat the entire recording
as music and skip this section. (“Nudge, nudge. Wink, wink. Sorry! Everything
you know is wrong!™)

By fine-tuning the import settings for voice recordings and sound effects, you
can save a significant amount of space without reducing quality. [ recommend
the following settings, depending on your choice of encoder:

v AAC: AAC allows you to get away with an even lower bit rate than MP3 to
achieve the same quality, thereby saving more space. [ recommend using
a bit rate as low as 80 Kbps for sound effects and voice recordings. Use
the Optimize for Voice option to filter the sound to favor the human voice.

v MP3: Use a low bit rate (such as 96 Kbps). You might also want to
reduce the sample rate to 22.05 kHz for voice recordings. You should
filter frequencies lower than 10 Hz because voice recordings don’t need
such frequencies.
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Converting Songs to a Different
Encoder Format in iTunes
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Converting a song from one format to another is useful if you want to use
one format for one purpose (such as burning the song to a CD) and a second
format for another task (such as playing the song on your iPod). Changing
formats is also useful for converting uncompressed songs or podcasts that
were created in GarageBand (or a similar audio-editing application) and
exported or copied to iTunes.

Converting a song from one compressed format to another is possible (say,
from AAC to MP3), but you might not like the results. When you convert a
compressed file to another compressed format, you're compressing further
an already-compressed file, further reducing the quality of the sound. You get
the best results by starting with an uncompressed song that was imported

in AIFF or WAV format and then converting that song to compressed AAC or
MP3 format.

You can tell the format of a song by selecting it, choosing File=>Get Info, and
then clicking the Summary tab. You can also add the Kind column, which
indicates the format for each song, to the List pane so that it is always visible —
choose View>View Options and turn on the Kind column option, or right-click
a column header and choose Kind from the contextual menu. You might want
to keep track of formats by creating version-specific playlists — say, a CD-
AlFF-version playlist and an iPod-MP3-version playlist.

To convert a song to a different encoding format, follow these steps:

1. Choose iTunes~>Preferences (Mac) or Edit~>Preferences (Windows),
click the General tab and then click the Import Settings button.

The import settings appear, allowing you to make changes to the encoding
format and its settings.

2. From the Import Using pop-up menu, choose the new encoding format
you want the song to be in after conversion.

3. In the Encoder dialog that appears, select the settings for that
encoder.

For example, if you're converting songs in the AIFF format to the MP3
format, choose MP3 Encoder from the Import Using pop-up menu and
then select the settings that you want in the MP3 Encoder dialog that
appears.

4. Click the OK button to accept the settings for your chosen format, and
click OK to accept your iTunes preferences changes.
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5. In the iTunes window, select the song(s) that you want to convert and
then choose Advanced=>Create encoder Version.

The encoding format that you chose in Step 2 (MP3, AAC, AIFF, Lossless,
or WAV) appears in place of encoder on the menu, as in “Create AAC
Version” or “Create MP3 Version.”

When the conversion is complete, a new version of the song appears

in your iTunes library (with the same artist and song name, so it’s easy
to find). iTunes doesn’t delete the original version — both are stored in
your music library.

If you convert songs obtained from the Internet, you might find MP3 songs
with bit rates as low as 128 Kbps. Choosing a higher stereo bit rate doesn’t
improve the quality — it only wastes space.

iTunes offers an automatic copy-and-convert operation for converting an
entire folder of albums or songs to another format. Press Option (Mac) or Alt
(Windows) before choosing the Advanced menu, and the Convert to encoder
menu option appears. Select this option and then choose a folder from the
open dialog. The entire contents of the folder are copied and converted
automatically. If you have a folder of AIFF tunes or albums, you can copy and
convert them to AAC or MP3 in one step.

Organizing Photos on Your Computer
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Using a computer to organize and archive all your digital photos makes
sense. You can organize massive quantities of photos in a photo library on
your computer. You can also add keywords, titles, dates, and film roll
information to each photo automatically, which helps make locating a
particular photo very easy. Keep the photos you like and delete the ones
you don'’t like. If you have a color printer, obtaining extra prints is as easy
as using the Print command. You can even e-mail the photos to a service for
high-quality prints.

Photo library software, such as iPhoto (on a Mac) or Adobe Photoshop
Elements (on a Windows PC), can organize any number of photos, limited
only by available hard drive space. At an average size of 2MB per photo
(many photos occupy less space), you can store 10,000 photos on a 20GB
hard drive. Of course, you can expand a photo library over multiple hard
drives or create multiple libraries. The number of digital photos that you can
manage has no practical limit.
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Most importantly, you can take your photos with you, safely tucked into your
iPod or iPhone, and even display them on your TV with Apple TV. On a Mac,
you can use iPhoto (version 4.0.3 or newer) to import photos into your
computer and organize them into albums. You can then use iTunes to
transfer photos and photo albums automatically from your iPhoto library to
your iPod, iPhone, and Apple TV.

On a Windows PC, you can use the older Adobe Photoshop Album or

Adobe Photoshop Elements (version 3 or newer) to import photos into your
computer and organize your photos into collections. You can then use iTunes
to transfer photos automatically from your Photoshop Album or Photoshop
Elements library. Note that if you use other photo-editing programs, you can
still update your iPod, iPhone, or Apple TV with the photos, as I describe

in Chapter 18 of the printed edition, but such programs may not let you
synchronize your photo collections automatically with your iPod, iPhone,
and Apple TV.

After you import the photos, your photo application stores them in its photo
library and displays them. For example, when iPhoto finishes importing, it
displays a small image for each photo in the photo library in the Last Import
section, as shown in Figure BC2-3. These small versions of your images are
called thumbnails.

You’ve probably seen photo albums with plastic sleeves for holding
photographic prints. A digital photo album is similar in concept but holds
digital photo files instead of prints. In both cases, an album is simply a way
of organizing photos and placing them in a proper sequence. You select the
photos from your photo library and arrange them in the order you want.
iPhoto uses album as its term; Adobe Photoshop Elements and Photoshop
Album call the album a collection. 1 use the term album for both.

You can use photo albums to assemble photos from special events (say, a
vacation) or to display a particular subject (such as your favorite nature
photos). If you have more photos in your library than what you want to put
on your iPod, iPhone, or Apple TV, consider organizing albums specifically
for transfer to the these devices and for automatic updating. The order that
your photos appear in the album is important because it defines the order of
photos in a slide show. You can also use albums to organize photos for a slide
show, QuickTime movie, or Web page.

You can make as many albums as you like, comprising any images from your
photo library. Because the albums are lists of images, they don’t use disk
space by copying the images. Instead, the actual image files remain in the
photo library. Similar to an iTunes playlist, a photo album is a reference list
of photos in your library. You can include the same photo in several albums
without making multiple copies of the photo and wasting disk space.
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